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Abstract

Cells in living tissues are exposed to substantial mechanical forces and constraints, imposed 

by neighboring cells, the extracellular matrix, and external factors. The mechanical forces and 

physical confinement can drive various cellular responses, including changes in gene expression, 

cell growth, differentiation, and migration. These responses have important implications in both 

physiological and pathological processes, such as immune cell migration or cancer metastasis. 

Previous studies have shown that nuclear deformation induced by 3D confinement promotes 

cell contractility but can also cause DNA damage and changes in chromatin organization, 

thereby motivating further studies in nuclear mechanobiology. In this protocol, we present a 

custom-developed, easy-to-use, robust, and low-cost approach to induce precisely defined physical 

confinement on cells using agarose pads with micropillars and externally applied weights. We 

validated the device by confirming nuclear deformation, changes in nuclear area, and cell viability 

after confinement. The device is suitable for short- and long-term confinement studies and 

compatible with imaging of both live and fixed samples, thus presenting a versatile approach to 

study the impact of 3D cell confinement and nuclear deformation on cellular function. This article 

contains detailed protocols for the fabrication and use of the confinement device, including live 

cell imaging and labeling of fixed cells for subsequent analysis. These protocols can be amended 

for specific applications.

Basic Protocol 1: Design and fabrication of the confinement device wafer

Basic Protocol 2: Cell confinement assay

Support Protocol 1: Fixation and staining of cells after confinement

Support protocol 2: Live/dead staining of cells during confinement
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INTRODUCTION:

Within the human body, cells often experience considerable physical confinement due to 

their 3D microenvironment. For instance, endothelial cells navigate through dense matrices 

during angiogenesis (Herbert & Stainier, 2011), immune cells migrate through vascular 

endothelial barriers and tissues during inflammation and wound healing (Friedl & Weigelin, 

2008; Luster et al., 2005), and cancer cells penetrate interstitial spaces as small as 1-2 μm in 

diameter during invasion, intravasation, and extravasation (Weigelin et al., 2012). Moreover, 

confinement in the tumor microenvironment promotes increased metastatic potential and 

drug resistance in tumor cells (Shen et al., 2021; Tse et al., 2012). In these processes, 

cells experience extensive deformations of the cell nucleus (Davidson et al., 2014; Friedl 

et al., 2011), the largest and stiffest organelle in the cell (Kalukula et al., 2022). Emerging 

evidence supports the idea that such nuclear deformation can modulate various cellular 

functions, ranging from cell contractility, cytoskeletal organization, chromatin modifications 

and gene expression to cell differentiation and viability (Gupta et al., 2012; Hsia et al., 2022; 

Lomakin et al., 2020; Venturini et al., 2020). The nucleus is thought to play a central role 

in cellular mechanosensing, i.e., in translating mechanical forces and physical confinement 

into biological responses (Enyedi & Niethammer, 2016; Kalukula et al., 2022; Kirby & 

Lammerding, 2018). Nonetheless, many of the molecular mechanisms linking mechanical 

inputs to biochemical outputs, as well as the mechanisms determining how 3D confinement 

alters cellular morphology and function of various cell types, remain to be elucidated.

These open questions have motivated the increasing use of either custom-developed or 

commercially available devices that provide precisely defined vertical or 3D confinement to 

cells. However, many of these devices are not suitable for long-term cell confinement, which 

is needed to accurately assess the biological consequences of confinement. For example, 

many devices use PDMS micropillars or glass coverslips to induce cell confinement (le 

Berre et al., 2012; Lee et al., 2018; Liu et al., 2015). Because these materials allow only 

limited media access to the cells, and thus limited nutrient availability, they substantially 

limit the duration that cells can be confined in vitro. Additionally, these devices often 

require the use of costly and bulky hardware such as vacuum pumps, syringe pumps, or 

pressurized air to induce confinement. Inconsistent or non-uniform confinement presents 

further challenges in some existing confinement assays. More recently, some devices have 

overcome these issues by using agarose pads for confinement, which allows nutrient 

accessibility for long-term cellular confinement (Prunet et al., 2020, García-Arcos et al., 

2023).

Here, we present a simple, easy to use confinement device containing agarose pads with 

micropillars of a specified height, a 3D printed weight holder, and simple disk weights 

(Figure 1A, B) to induce 3D confinement of cells to specific heights for up to 24 hours 

(Figure 1C). Note that 3D confinement is typically associated with both (1) spatial constraint 

resulting from the confinement and (2) mechanical compression, resulting in deformation 

of the cell and nucleus. Since the compressive forces may vary over time, whereas the 

spatial constraint of confinement remains constant once applied to the cells, we refer to 

these devices as confinement devices, and not compression devices. To fabricate the device, 

photolithography is used to create a pillar array with SU-8 photoresist on a silicon wafer. 
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The agarose device is then formed by casting agarose onto the silicon wafer containing the 

pillar design fabricated to the height of interest. After the agarose device is formed and 

individual devices are cut out, it is placed onto cells seeded in a glass dish upon which the 

weight holder and weights can be added directly on top of the agarose device to induce 

nuclear confinement.

We provide protocols to fabricate the silicon wafer used to form the agarose confinement 

devices (Basic Protocol 1) and how to successfully induce and measure confinement 

of cells with the device (Basic Protocol 2). Additionally, we provide two supplemental 

protocols to demonstrate how to fix cells after confinement for further imaging applications 

(Support Protocol 1) and how to perform live/dead cell staining and imaging after 

confinement (Support Protocol 2). This device can effectively induce precisely controlled 

cell confinement to elucidate how cells respond to 3D confinement and identify underlying 

mechanisms of mechanotransduction.

BASIC PROTOCOL 1: Design and fabrication of the confinement device 

wafer

To form the agarose devices with micropillars, agarose is cast onto a mold consisting of 

a silicon wafer microfabricated to contain the negatives of the desired device features. 

Since the mold contains features of different heights, it is fabricated using two layers of 

photoresist, each corresponding to a specific height. The silicon wafer is fabricated using 

photolithography techniques, in which SU-8 photoresist is spun onto the wafer, exposed 

with UV light through a photomask containing the design of interest for each layer, and 

developed to remove the unexposed photoresist. This process is repeated for each layer of 

photoresist. The final silicon wafer contains two layers of SU-8 photoresist: a lower layer 

and an upper layer. The lower layer is used to fabricate the micropillar features, with the 

height of the layer corresponding to the desired height of the cells during confinement, 

whereas the upper layer serves to help remove the agarose device from the silicon wafer 

without damaging the micropillars or creating an agarose lip when cutting out the device 

that protrudes beyond the micropillars. We recommend a micropillar height of 2-5 μm for 

confinement and a height of 10-15 μm for the control condition, but the exact dimensions 

will depend on the height of the cell when in unconfined 2D conditions, which varies 

between cell types and cell culture conditions. In the following, we provide protocols for 

the fabrication of devices with micropillar heights of either 3 μm (confinement) or 10 μm 

(unconfined control). One wafer should be fabricated containing a 3 μm lower layer, and 

a separate wafer should be fabricated containing a 10 μm lower layer. The upper layer 

contains a 500 μm tall by 3mm wide circular outline of the device to help with removing the 

agarose from the wafer. This layer will result in a circular undercut groove in the agarose 

pad to ensure that when cutting out individual agarose devices, the pillar features are not 

cut, which would prevent solid contact of the pillars with the substrate during confinement. 

The upper layer is identical for both wafers. The protocol assumes some basic knowledge 

and experience with photolithography and wafer fabrication. If needed, please consult with 

available experts or external service providers. All fabrication steps should be performed in a 

clean room facility with proper safety equipment and precautions.
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Materials:

Piranha etch solution* (3:1 sulfuric acid: 30% hydrogen peroxide)

SU-8 2002 (Kayaku Advanced Materials, item no. Y111029 0500L1GL)

SU-8 10 (Kayaku Advanced Materials, item no. Y131259 0500L1GL)

SU-8 2150 (Kayaku Advanced Materials, item no. Y111077 0500L1GL)

Acetone, semiconductor grade* (Transene, product no. UN109)

SU-8 developer* (Kayaku Advanced Materials, item no. Y020100 4000L1PE)

Deionized (DI) water

Isopropyl alcohol (IPA), semiconductor grade* (VWR, cat. no. JT9079-05)

Hydrophobic wafer coating* (FOTS (1H,1H,2H,2H-perfluorooctyl trichlorosilane) 

deposition or Bosch process to perform sulfur hexafluoride (SF6) etch with 

octafluorocyclobutane (C4F8) deposition).

AutoCAD software (Tanner L-edit version 2020u7.1, KLayout, or equivalent)

GenISys BEAMER software (version 6.3.1)

Chrome Photomask, 5 × 5 × 0.90 inch, quartz substrate (Telic)

Heidelberg DLW 2000 (Heidelberg Instruments)

Hamatech wafer processor

CZ silicon wafer, 4-inch diameter, n-type, 500-550 μm thick* (Nova Wafers)

Oven capable of reaching and maintaining temperature of 90°C

Chemical fume hood compatible with class II photoresist materials

Disposable pipettes* (VWR cat. no. 414004-023)

Resist spin coater

Wafer tweezers (Excelta Corp, model 491-SA-PL)

CleanTips ® Swabs (Texwipe, TX761)

Cleanroom Amplitude ™ Zeta ™ Wipe (Contec, AMZE0001)

Hot plate with adjustable ramp rate (Fairweather TPS66 or equivalent)

Contact aligner (Karl Suss MA6 or equivalent)
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Long pass filter for near UV light (PL-360LP from Omega Optical or equivalent)

Rubylith masking film (Ulano, RU3 151800)

Pyrex ® Glass dish, 1200 mL, with dimeter larger than 4-inch wafer (Millipore Sigma, SKU 

CLS3140150)

Kapton® tape*, 1/8 inch width (ULINE S-14532)

Razor blade* (VWR cat. no. 55411-040)

Profilometer (Tencor P7 profilometer or equivalent)

Oven capable of maintaining temperature of 200°C (YES polyimide bake oven or 

equivalent)

Molecular vapor deposition tool (MVD 100 or equivalent) or deep silicon etcher capable of 

running the Bosch Process (Unaxis 770 Deep Silicon Etcher or equivalent)

* Many of these items are general supplies available in clean-room facilities and provided 

by the facility. We have provided catalog numbers when available, but the specific product 

available in other clean room facilities may vary. We do not expect this to be an issue. Please 

consult with your local clean room operators if needed.

Protocol steps with step annotations:

Design and generate photomasks, prepare silicon wafers

1. Design the photomask for each layer using the desired features and geometries 

using an AutoCAD software such as Tanner L-edit (version 2020u7.1) or 

KLayout. For complex designs, such as our design containing multiple circular 

features, we recommend performing Boolean subtraction using the GenISys 

BEAMER software (version 6.3.1). In that case, to design the first layer 

photomask, the array of individual circles was subtracted from the larger 

blue circle (Figure 2A). The photomask designs for the device used in our 

applications, which fits into a 35-mm glass bottom dish, is available on GitHub 

(https://github.com/Lammerding/Confinement-Device) and can be modified if 

desired. Each photomask design includes complementary alignment marks to 

align each layer with the previous one on the wafer during exposure. The first 

layer photomask will generate alignment marks on the lower layer of photoresist. 

The second layer mask will contain alignment marks that will be aligned to the 

wafer containing the first layer alignment marks (Figure 2B, C). After ensuring 

the tonality of the digital mask design is correct, convert the mask design to a 

GDSII file. The file will then be converted to a DXF file using a conversion 

program. This is the file format accepted by the Heidelberg DLW2000 mask 

writer. Other instruments may use a different file format.

2. For each layer, print the photomask design on a chrome mask using a mask 

writer, such as Heidelberg DLW2000, following the manufacturer’s instructions.
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3. Develop the photomasks and perform a chrome etch using a Hamatech wafer 

processor. Strip the excess photoresist from the photomasks using a resist hot 

strip bath and dry the photomasks completely. The final photomasks will be used 

to expose the photoresist on the silicon wafer.

The Hamatech wafer processor is a general tool containing a closed and safe 

environment that can be used with many photomasks and wafer processes. The 

photomask will first go through a developer process, and then a separate chrome 

etch process. Many cleanrooms will have standard protocols for these processes.

4. Clean the silicon wafers to be used with a Hamatech wafer processor equipped 

with a standard Piranha etch solution. The tool will automatically mix the 

sulfuric acid and hydrogen peroxide solutions, ensuring user safety. The tool 

performs a series of cleaning and DI water rinsing steps for approximately 8 

minutes.

The Piranha etch solution is used to clean organic material from the wafer 

and prepare the surface of the wafer. Alternatively, a Nanostrip solution can 

be used in a general chemistry hood. We recommend following your particular 

clean room’s guidelines. When planning to make multiple identical wafers, for 

example, to produce multiple confinement devices at once, it is more efficient to 

fabricate the wafers in parallel. In that case, each wafer is processed as described 

here.

5. Dehydrate the wafers overnight in a 90°C oven. This is critical before spinning 

each layer of SU-8 photoresist. Allow the wafer to cool to room temperature 

before spinning photoresist.

SU-8 fabrication of 3 μm lower layer features (use first wafer for this)

6. Center the wafer on a spin coater, add 3 mL of SU-8 2002 to the center of 

the wafer, and run the spin process, selecting settings (Table 1) to produce a 3 

μm thick SU-8 layer. Remove photoresist from the outer 5 mm perimeter of the 

wafer and the back of the wafer using a clean room swab soaked with acetone.

Removing the outer 5 mm of photoresist (the “edgebead”) is common practice 

to ensure the wafer does not get stuck in other tools used (i.e., the deep silicon 

etcher tool). Additionally, any photoresist on the back of the wafer will come in 

contact with the surfaces of the hot plates and can cause the wafer to adhere to 

the hot plate during baking and leave residual photoresist on the hotplates.

7. Bake the wafer for 2.5 minutes on a hot plate pre-heated to 95°C. Remove 

the wafer from the hotplate and allow the wafer to cool gradually to room 

temperature.

If you have access to a cooling block, place the wafer on the cooling block and 

allow it to cool for approximately 1 minute. Alternatively, you can place the 

wafer in a wafer carrier, and it will cool in approximately 3-5 minutes.
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8. Mount the wafer with the photoresist and the photomask of interest on a contact 

aligner tool. The set up will vary depending on the contact aligner used, but in 

general the wafer is placed with the photoresist side up and the photomask mask 

is placed on top of the wafer with the chrome side of the photomask facing the 

photoresist. During the exposure (see next step), the light source will expose the 

photoresist side of the wafer through the photo mask.

9. Expose the photoresist to UV light using a vacuum contact setting. The exact 

duration will depend on the light source, thickness of photoresist, and the area 

of photoresist to be exposed. In our protocol, an exposure time of 15 seconds 

produced the correct sized features for the 3 μm tall SU-8 layer. A UV light long 

pass filter must be used for SU-8.

It is necessary to perform an exposure array testing multiple exposure times to 

determine the correct exposure time. Rubylith can be used to cover portions 

of the photomask to perform an exposure array on one wafer. Exposure time 

will depend on the power of the UV source, so it will vary between different 

contact aligners/steppers and can also change over time. For large features that 

do not need high resolution such as the pillars in our design, we used ‘hard 

contact mode’ for alignment, which is less precise than ‘vacuum contact mode’ 

as described in SUSS MA6 user manual section “1.4.1 Exposure Programs”. 

After exposure and development, inspect the size of the features on the wafer 

with a microscope to determine the optimal exposure time.

10. Remove the wafer from contact aligner and bake the exposed wafer on a 95°C 

hot plate for 3.5 minutes. Remove the wafer from the hotplate and allow the 

wafer to cool gradually to room temperature on a cooling block for 1 minute.

11. Add the wafer to a glass dish containing SU-8 developer. Gently swirl the dish 

for 5 seconds and remove the wafer from the developer. Rinse the wafer once 

with DI water. Repeat 5-second developer and water rinses until there is no 

residue left on the wafer. For thin layers, repeated short rinses with developer 

and DI water are helpful to avoid overdeveloping the wafer.

12. Let the wafer dry in a fume hood for at least 4 hours and up to 24 hours. Rinse 

the wafer once with isopropyl alcohol (IPA) and then DI water. Dry the wafer 

using a pressurized nitrogen nozzle.

It is important to use pressurized nitrogen nozzles to dry substrates instead of air 

because nitrogen is inert, does not contain water, and nitrogen will not react with 

water on the surface of substrates.

13. Measure the height of the photoresist layer using a Profilometer (e.g., Tencor 

P7).

14. Dehydrate wafers overnight in a 90°C oven overnight before spinning a second 

layer of photoresist on the wafer (see step 15 and following).
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SU-8 fabrication of 10 μm lower layer features (use second wafer for this)

6. Center the wafer on a spin coater, add 3 mL of SU-8 10 to the center of the 

wafer, and run the spin process using the settings provided in Table 2 to produce 

a 10-μm thick photoresist layer. Remove photoresist from the outer 5 mm and 

back of the wafer using a clean room swab soaked with acetone.

7. Bake the wafer on a hot plate heated to 95°C for 3.5 minutes. Remove the wafer 

from the hotplate and allow the wafer to cool gradually to room temperature on a 

cooling block for 1 minute.

8. Mount the wafer containing photoresist and the photomask of interest on a 

contact aligner tool. The set up will vary depending on the contact aligner 

used, but in general the photomask mask is placed over the wafer containing 

photoresist, with the chrome side of the photomask facing the photoresist on the 

wafer. During the exposure, the light source will expose through the photo mask 

to the wafer containing photoresist.

9. Expose the photoresist to UV light using a vacuum contact setting. In our 

protocol, an exposure time of 17.5 seconds produced features in the correct size 

for the 10 μm tall SU-8 layer. A UV light long pass filter must be used for SU-8.

10. Remove the exposed wafer from the contact aligner and bake the exposed wafer 

on a 95°C hot plate for 3.5 minutes. Remove the wafer from the hotplate and 

allow the wafer to cool gradually to room temperature on a cooling block for 1 

minute.

11. Add the wafer to a glass dish containing SU-8 developer. Gently swirl the dish 

for 5 seconds and remove the wafer from the developer. Rinse the wafer once 

with DI water. Repeat 5 second developer and water rinses until there is no 

residue on the wafer. For thin layers, repeated short rinses with developer and DI 

water are helpful to avoid over developing the wafer.

12. Let the wafer dry in a fume hood for at least 4 hours and up to 24 hours. Rinse 

the wafer once with IPA and then DI water. Dry the wafer using a pressurized 

nitrogen nozzle.

13. Measure the height of the photoresist layer using a Profilometer (e.g., Tencor P7 

Profilometer) to confirm that it matches the desired height of the corresponding 

features.

14. Dehydrate wafers overnight in a 90°C oven before spinning a second layer of 

photoresist on the wafer.

SU-8 fabrication of 500 μm upper layer features and final processing (apply to both wafers)

15. Cover alignment marks on the wafer containing lower layer features using a 

small piece of Kapton® tape. This preserves alignment marks during the upper 

layer spin process.

16. Center the wafer on a spin coater, pour 5-7 mL of SU-8 2150 on the center of 

the wafer, and run the spin process. The spin settings for obtaining a 500 μm 
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layer are provided in Table 3. Let the wafer rest for 10 minutes in the spin coater. 

Remove the photoresist from the outer 5 mm and back of the wafer using a clean 

room swab and clean room wipes soaked with acetone.

SU-8 2150 is extremely viscous and must be poured onto the wafer (i.e., it 

cannot be pipetted). If the spin is uneven, pour more photoresist onto the center 

of the wafer and spin the wafer again. Letting the wafer rest for 10 minutes after 

spinning will help create an even thickness. Be careful to hold the wafer level 

while removing the outer 5 mm photoresist and cleaning the back of the wafer.

17. Place the wafer on a room temperature hotplate and ramp the temperature to 

65°C at a rate of 1.5 °C/minute. Hold at 65°C for 30 minutes, and then ramp to 

95°C at 1.5°C/minute. Hold the temperature at 95°C for 16-24 hours, turn off the 

hotplate, and allow the wafer to gradually cool to room temperature on the hot 

plate for approximately 2 hours.

The pre-exposure bake is usually performed at 95°C for SU-8 photoresist. 

The longer bake time and more elaborate protocol is needed for the thicker 

photoresist layer to avoid cracks or delamination due to thermal stress.

18. Remove the Kapton® tape under the upper layer of photoresist covering the 

alignment marks on the lower layer of photoresist. This can be done by carefully 

using a razor blade to score the edges of the taped area, followed by tweezers to 

peel the tape off of the wafer. Use a microscope to confirm the alignment marks 

are visible on the wafer.

19. Mount the wafer with the photoresist and the photomask of interest on a contact 

aligner tool. Align the photomask to the alignment marks on the wafer. Expose 

the photoresist for 3 intervals of 20 seconds each, with 20 seconds of rest in 

between exposures using a hard contact setting. A UV light long pass filter must 

be used for SU-8.

Longer exposure times (above 30 seconds) risk SU-8 cracking and defects, so 

we recommend performing multiple shorter exposures to allow the wafer to cool 

between multiple exposures.

20. Place the wafer on a room temperature hotplate and ramp the temperature to 

95°C at a rate of 1.5 °C/minute. Hold the temperature at 95°C for 5 minutes, 

turn off the hotplate, and allow the wafer to gradually cool to room temperature 

on the hot plate for approximately 2 hours.

21. Add the wafer to the bottom of a glass dish containing ~500 mL of SU-8 

developer. The amount of developer can vary but should generously cover 

the entire wafer. Allow the wafer to develop for one hour, replace with fresh 

developer, and allow the wafer to develop for one additional hour. Rise the wafer 

with DI water.

If there is still residue on the wafer after rinsing with DI water, place the wafer 

back into developer for 5-minute periods and perform alternating developer and 

DI water rinses until there is no longer residue. You should use a microscope 

Elpers et al. Page 9

Curr Protoc. Author manuscript; available in PMC 2024 July 01.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



to confirm features on the device do not contain debris from undeveloped 

photoresist. For the development process, we found that including a rotating 

stir bar in the developer solution can cause delamination of the photoresist and 

should be avoided, even if it requires a longer development process.

22. Let the wafer dry in a fume hood for at least 4 hours and up to 24 hours. Rinse 

the wafer once with IPA and then DI water. Dry the wafer using a pressurized 

nitrogen nozzle.

A long drying step is recommended to allow any remaining solvents to 

evaporate. These solvents can otherwise interfere with the next steps of applying 

the hydrophobic coating to the wafer.

23. Perform a hard-bake on the wafer in an oven by gradually ramping the 

temperature to 200°C, holding for one hour, and then gradually allowing the 

wafer to cool to 50°C. Depending on how fast the oven cools it will take 

approximately 2 hours to reach 50°C. Transfer wafer to a wafer holder and allow 

the wafers to cool to room temperature for approximately 10 minutes.

Hard baking increases the thermal stability of the photoresist, and removes 

any leftover solvent in the photoresist that could interfere with future etching 

processes (i.e. the hydrophobic coating with C4F8). Do not open the oven door 

during the bake while the oven is above 100°C. This will cause the wafers to 

shatter. When removing the wafers from the oven, place them in an upright 

wafer holder to cool gradually to room temperature. Do not place the wafers flat 

directly on a cold metal benchtop.

24. Apply a hydrophobic coating to the wafer. This can be done using either fluoro-

octyl trichlorosilane (FOTS) deposition with a Molecular Vapor Deposition 

(MVD) tool or by running a SF6 etch and C4F8 deposition (Bosch process) 

in a Deep Silicon Etcher. Measure the contact angle on the silicon wafer using a 

video contact angle (VCA Optima) system, ensuring a contact angle of ≥ 95°.

Unlike PDMS, agarose can be cast directly from the silicon wafer, without 

substantial wear or delamination of the wafer. However, if desired, a plastic 

mold can be generated from a PDMS cast of the silicon wafer to provide an 

even more permanent mold that can be used to cast the agarose devices. We have 

previously published a detailed protocol for the fabrication of plastic molds from 

PDMS casts (Agrawal et al., 2022).

BASIC PROTOCOL 2: Cell confinement assay

This section describes the steps to make the agarose devices, induce confinement of cells 

using the devices (Figure 3), and confirm cell confinement by measuring nuclear cross-

sectional area and nuclear height, which should increase (area) and decrease (height) under 

confinement. For biological studies, we recommend comparing cells under three different 

conditions: (1) an unconfined control, (2) confinement with a device sufficient to induce 

substantial cellular and nuclear deformation (typically 3-5 μm height), and (3) a control 

with a device that is taller than the unconfined cell height and thus does not induce cellular 
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deformation but controls for the presence of the agarose pad and the squishing of some cells 

under the micropillars (typically 10-15 μm height). In our example, we use MDA-MB-231 

human breast cancer cells confined to 3 μm height, which is approximately 60% of the 

original nuclear height of ~5 μm, and a control device with 10-μm tall micropillars (Figure 

4A). Different cell types may have different heights and may tolerate different degrees of 

confinement.

For the experiments, the cells of interest are seeded onto 35-mm glass bottom dishes that 

have been coated previously with the appropriate extracellular matrix (e.g., collagen or 

fibronectin), using standard cell culture protocol. After overnight incubation to promote 

cell adhesion, the cells are imaged on confocal microscope to measure nuclear height prior 

to confinement. Immediately prior to confinement, the agarose devices are prepared by 

casting agarose onto the silicon wafer described above in Basic Protocol 1. The individual 

devices are cut out and soaked in media to reduce media absorption once they are placed 

onto the dish with the cells. To induce confinement, a 3D-printed weight holder is placed 

onto the agarose device, followed by the desired amount of weight. For short experiments 

inducing confinement for 3-6 hours, 10 grams of weight is added to the device. For longer 

experiments (e.g., 18-24 hours), the amount of weight is decreased to 5 grams to avoid 

excessive compression of the device over time. Cells can be imaged during the experiment to 

confirm confinement, e.g., based on the changes in nuclear height and/or cross-section. The 

nuclear cross-sectional area is expected to increase upon confinement to 3 μm but should not 

change when cells are subjected to the control device with taller micropillars (Figure 4B). 

Nuclear height quantification is used to confirm even confinement in cells across the entire 

device (Figure 4C). This protocol can be applied to a wide variety of cell types, as it is easy 

to modulate various parameters such as the cell confluency and amount of weight used.

Materials:

Cells of interest (e.g., MDA-MB-231 human breast cancer cells (ATCC HTB-26 ™) 

genetically modified to express H2B mNeonGreen (Allele Biotechnology) or another 

nuclear label)

Dulbecco’s Modified Eagle Medium (DMEM) cell culture media supplemented with fetal 

bovine serum (FBS) and penicillin/streptomycin (see recipe in Reagents and Solutions)

1× Dulbecco’s phosphate-buffered saline (DPBS), no calcium, no magnesium (see recipe in 

Reagents and Solutions)

Fibronectin (EMD Millipore Corp, cat. no. FC10-5MG) diluted in 1× DPBS to 5 μg/mL or 

type I collagen (Corning, cat. no. 354236) diluted in 0.02N acetic acid to 0.05 mg/mL

Trypsin-EDTA, 0.25% with phenol red (Gibco/ThermoFisher, cat. no. 25200-072)

Cell media suitable for live cell imaging (e.g., see recipe for Fluorobrite media or use media 

compatible with specific cell type of interest)

Agarose (SeaKem LE Agarose, Lonza, cat. no. 50004, or comparable)
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FITC dextran (Invitrogen, cat. no. D7136 or equivalent)

CO2 incubator for cell culture (e.g., Thermo Scientific Forma™ Steri-Cycle™)

Water bath set to 37°C

Laminar flow biosafety cabinet (e.g., The Baker Company SterilGARD® Class II Type A2)

35 mm dish with glass bottom 0.17mm thick (e.g., FluoroDish, World Precision Instruments, 

cat. no. FD35-100)

Cell culture flasks (e.g., 25 cm2 flask, Corning, cat. no. 430639)

Inverted bright field microscope

15 mL conical tube (e.g., Corning, cat. no. 352096)

Cell culture centrifuge

Cell counter (e.g., Reichert Bright-Line® Hemocytometer or CellDrop™ Automated Cell 

Counter)

Inverted confocal microscope with a 40× immersion objective, motorized stage, and 

mounted microscope camera for image acquisition (cells can also be observed with a 10× or 

20× non-immersion objective, but high NA objectives are needed for accurate nuclear height 

measurements)

100 mm polystyrene plastic petri dish (e.g., VWR, cat. no. 25384-342) with bottom removed 

carefully using an X-Acto knife

17 mm diameter circular metal punch or X-Acto knife

Flat-tipped tweezer (VWR, cat. no. 89259-954)

Kimwipes (Kimtech, cat. no. 34133)

35 mm polystyrene plastic petri dish (e.g., VWR, cat. no. 25384-342)

3D printed weight holder (printed using an Ultimaker S5 3D printer with Ultimaker Tough 

PLA filament, STL files available on GitHub.

Disk weights ranging from 2g to 10g with slots (e.g., Amazon)

Microscopy software capable of automated capture of Z-stack (e.g., Zeiss Zen Black)

FIJI/ImageJ or equivalent image-processing software
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Protocol steps with step annotations:

Extracellular matrix coating and cell seeding

1. Culture cells according to methods appropriate for specific cell lines (Phelan & 

May, 2017; Picot, 2004). Cells should be cultured in a 37°C incubator with 5% 

CO2. All culture media should be warmed to 37°C in a water bath. Work should 

be performed in an approved biosafety cabinet. We have demonstrated that this 

protocol works consistently with adherent cells, however, due to the ability to 

modulate experimental parameters, this device should also be suitable for cells 

cultured in suspension.

2. 18-24 hours before the cell confinement assay, coat the glass bottom dishes 

with the appropriate extracellular matrix molecules (e.g., 5 μg/mL fibronectin or 

0.05 mg/mL type I collagen solution) for 2 hours at 37°C or overnight at 4°C 

(Agrawal et al., 2022).

The specific choice of extracellular matrix coating will depend on the cell lines 

used in the experiments. Fibronectin should be used at a final concentration of 5 

μg/mL in 1X DBPS. Incubate glass dishes with fibronectin solution for 2 hours 

at 37°C. Dilute type 1 collagen in 0.02 N Acetic acid to a final concentration of 

0.05 mg/mL. Coat glass dishes with collagen solution and incubate overnight at 

4°C. For collagen coatings, it is necessary to wash the dishes with PBS or cell 

media prior to seeding the cells to avoid acidification of cells and cell media 

due to the acetic acid present in the collagen solution. Seeding cells on glass 

will likely change the nuclear and cellular morphology and impact the cellular 

response to confinement. In our experience, fibronectin provides a more even 

coating and consistent nuclear height compared to a collagen substrate, but this 

may depend on the specific conditions and cell lines.

3. Detach cells using standard cell culture methods. For MDA-MB-231 cells in a 

T-25 flask, aspirate the cell media and rinse flask once with 1× DPBS. Add 500 

μL of trypsin-EDTA and incubate for 3-5 min until cells are detached. Check 

that all cells have detached using an inverted bright field microscope. Add 2 mL 

culture media to neutralize trypsin and transfer cell suspension to a conical tube. 

Rinse flask with 2 mL media three times, adding the media to the conical tube 

and bringing the final volume to 10 mL.

4. Centrifuge detached cells at 300 × g for 5 min to pellet the cells.

5. Aspirate the supernatant and resuspend cell pellet in 5 mL culture media.

6. Count the cells using a hemocytometer or an automated cell counting device.

7. Seed cells onto the coated dishes at a density of 75,000-100,000 cells/dish 

(corresponding to ca. 37,500 – 50,000 cells/mL in 2 mL of media).

For optimal confinement, cells should be between 50 to 70% confluence on the 

day of the experiment.
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Preparing cells for confinement and imaging

8. Optionally, for cells that do not contain a genetically encoded fluorescent 

nuclear label, stain cells with a live cell nuclear/DNA stain (e.g., Hoechst 33342 

or SPY555-DNA) prior to imaging.

For live cell imaging, fluorescent labels or dyes that use longer wavelength 

for excitation (e.g., mNeonGreen, mCherry, mScarlet, SPY555 or SPY650) are 

preferred as imaging them is less phototoxic compared to fluorophores requiring 

shorter wavelengths.

9. 18-24 hours after cell plating, replace cell culture media with 500 μL of cell 

imaging media (e.g., Fluorobrite) and place the 35 mm glass bottom dish on the 

microscope stage.

Changing the amount of media will affect the efficiency of confinement, as the 

agarose must displace media to come in contact with the bottom of the dish. If 

using a dish with a different surface area, the amount of media will need to be 

adjusted.

10. Acquire multiple fields of Z-stack images using a 40× immersion objective on a 

confocal microscope to measure the average nuclear height prior to confinement. 

We found that Z-stacks with 0.5 μm intervals are typically sufficient. The dish 

can be kept on the microscope while the agarose device and weights are added. 

Alternatively, the dish can be removed from the microscope until after step 

19, and then the dish can be placed back onto the microscope to confirm 

confinement.

Preparing the agarose confinement device

11. Prepare a 3% agarose solution by adding 1.5 grams of agarose to 50 mL of 1× 

DPBS. Dissolve the agarose by microwaving the solution in 15 second intervals 

for approximately one minute. Swirl the solution to ensure that all the agarose is 

dissolved and then let the solution cool down for 2 minutes.

Typically, a minimum of 50 mL of 3 % agarose is prepared. Tissue culture grade 

DPBS is essential to maintain the correct pH of the agarose. If air bubbles form 

during the microwaving step, use a vacuum desiccator to evacuate the bubbles. 

Usually, a short vacuuming for 10- 30 seconds and the rapidly releasing the 

vacuum will clear bubbles from the agarose. A video of steps 11-15 is available 

(Supplemental Video 1).

12. While the agarose is cooling down, prepare the wafer that serves as the mold for 

the desired confinement height. Rinse the wafer once with DI water and dry with 

an air nozzle. Place the 100 mm plastic ring on top of the wafer to serve as a 

mold to cast the melted agarose. This will ensure the thickness of agarose is the 

same for every casting. The melted agarose should not leak under the plastic ring 

due to its high viscosity.

13. Carefully poor 15 mL of the 3 % agarose solution on the wafer. Rotate the wafer 

gently, while keeping the 100 mm plastic ring in place to ensure that the agarose 
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is evenly spread across the wafer. The height of the agarose layer should be 

approximately 15 mm. Let the agarose solidify for 10 minutes.

The agarose devices should be freshly made for each experiment, and 

immediately used after preparing. This will ensure the agarose does not dry 

out before being placed into the dish with cells.

14. Carefully remove the 100 mm plastic ring without removing agarose by using 

tweezers to separate the agarose from the plastic ring. Cut out the individual 

agarose devices using the 17 mm diameter circular metal punch or an X-Acto 

knife, but do not yet remove the agarose from the silicon wafer.

15. Remove the surrounding excess agarose using flat-tipped tweezers, leaving the 

individual agarose devices on the wafer.

In our experiments, we do not sterilize the agarose, and we do not see any signs 

of contamination when culturing cells in the device for up to 24 hours (using 

media containing antibiotics and using tissue culture grade PBS). Optionally, the 

agarose devices can be sterilized with UV light, but this should be limited to 10 

minutes or less to minimize the risk of the devices drying out before use.

Cell confinement

16. Gently lift up the edge of the agarose device and pass the flat-tip tweezer under 

the agarose without puncturing the agarose. Place the agarose device in a 35 mm 

dish containing 2 mL of cell imaging media and soak in the media for 1 minute.

Soaking the agarose is essential to prevent initial absorption of media once 

the agarose device is placed into the dish with the cells. Flat-tip tweezers are 

essential for handling of the agarose devices from this point forward. Pointed 

tweezers can easily puncture or tear the agarose. A video of steps 16-19 is 

available (Supplemental Video 2).

17. Using the flat-tip tweezers, gently lift the agarose device out of the dish used 

to soak it in media and place the agarose device on cells in the dish. Wait for 

~3 minutes to let the dish with the device equilibrate. At this point, the device 

should not be compressing the cells yet. Confocal Z-stacks can be acquired 

after adding the agarose device onto the cells to ensure that no confinement is 

occurring.

If using 35 mm dishes that contain a circular well with the glass coverslip at the 

bottom, ensure that the cell culture media (500 μL) that had been added to the 

dish in step 9 is covering the cells at the bottom of the well, and has not been 

displaced to the periphery of the 35-mm dish.

18. Spray the weight holder with 70% ethanol to disinfect it and dry with a 

Kimwipe. Gently add the weight holder to the agarose device and let it sit for 3 

minutes. At this point, cells should not be compressed yet, which can be verified 

by acquiring Z-stacks of the cells, or by assessing nuclear cross-section.
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19. Use the tweezers and carefully add the desired amount of weight onto the weight 

holder. For short term confinement experiments (3-6 hours) we add 10 grams of 

weight onto the device and confirm that confinement occurs within 30 minutes 

of adding the weight. For experiments in which cells are confined for 18-24 

hours, we add 5 grams of weight, and confirm that confinement occurs within 2 

hours of placing the weight onto the device.

The relatively low weight and long time to achieve full confinement helps to 

minimize the shear stress associated with displacing the media between the glass 

surface and the agarose pad. Larger weights will result in faster confinement 

but may also result in increased fluid shear stress and could lead to excessive 

compression of the agarose pad, and thus over-confinement. Particularly for 

longer experiments (>18 hours), we found that although using less weight takes 

longer to achieve full confinement, it lowers the risk of over-confinement. We 

anticipate that depending on the cell type, cell density, and stiffness of the 

cells, the exact amount of weight added will need to be adjusted. Optionally, 

fluorescently labeled dextran can be added to the cell media to visualize 

the amount of media between the glass dish and agarose, further confirming 

confinement (Figure 5A). For overnight experiments, add 0.5 mL of appropriate 

cell media to the outside of the dish to ensure the cells have adequate nutrient 

supply.

20. Acquire Z-stacks to measure the height of the nuclei after confinement. We 

recommend imaging multiple positions to confirm that the confinement height 

is uniform. Another quick way to confirm that the micropillars of the agarose 

device are touching the glass dish, and thus the device is achieving the desired 

confinement, is by looking for areas where the cells are completely squished 

under the pillars (Figure 5B). In addition, confinement should result in an 

increased nuclear cross-sectional area in cells located between the pillars.

Image analysis with Fiji/Image J

Quantification of nuclear cross-sectional area to confirm confinement

1. Import Z-stacks of images containing fluorescently labeled nuclei.

If only performing nuclear cross-sectional area measurements, 3D confocal Z-

stacks may not be required, and single sections capturing the mid-plane of the 

nucleus or wide-field images of the cell/nucleus may be sufficient. If only using 

single images instead of 3D image stacks, skip forward to step 3.

2. Select Image > Stacks > Z project. You will be prompted to select the projection 

type and the first and last stack. Keep the “start slice” and “stop slice” as they are 

and make sure to select “average intensity” for the projection type. Click “OK” 

to confirm selections.

If you did not take Z-stacks, you can skip this step.
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3. Select Image > Adjust > Threshold. A Threshold window will open; change the 

default filter to ‘Huang’ and select the “dark background” option. Click “Apply” 

to apply changes.

If you notice that some nuclei are touching, it may be necessary to apply an 

additional filter to split them. In that case, select Process > Binary > Watershed.

4. Select Analyze > Set measurements. A window will open to check parameters of 

interest. Ensure that “Area” is checked.

5. Select Analyze > Analyze Particles. You will be prompted to set the minimum 

and maximum sizes of the particles. For our cells, we set the minimum size at 

40 μm2 and select “infinity” for the maximum size. Select “Add to Manager” and 

“Exclude on edges”. Click “OK” to confirm selections.

6. A region of interest (ROI) Manager window will open and an ROI outlining the 

nuclei will appear on the thresholded image. In this window, click “Measure”.

7. A new window will open with the measurement results. Results are given in units 

of μm2.

8. Compare results between cells in unconfined conditions, confinement, and in 

the control device. Confinement should result in an increase in nuclear cross-

sectional area (Figure 4B).

Quantification of nuclear height to confirm confinement

9. Import Z-stacks of images containing fluorescently labeled nuclei. We use the 

“3D Objects Counter” plugin to measure nuclear height (Bolte & Cordelières, 

2006).

Nuclear height measurements require confocal Z-stacks acquired with a high 

resolution, high NA objective to ensure adequate resolution in the Z-direction. 

We find that images acquired with a 40× water immersion objective (NA = 1.2) 

or a 63× oil immersion objective (NA = 1.4) work well.

10. Select Analyze > 3D OC Options. You will be prompted to set measurements 

of interest. To measure nuclear height, select “Bounding Box”. Click “OK” to 

confirm selection.

11. Select Analyze > 3D Object Counter. You will be prompted to set a threshold 

to the image stack. Optionally, you can enter a size filter for objects. Select 

“Exclude objects on edges” and under “Maps to show” select “Objects”. This 

will generate a new image stack with numbered objects that are measured. 

Check the “Statistics” option to export the data with results to a new window in 

Fiji. When finished, select “OK” to perform the analysis.

12. The window with the results will open. The dimensions of the bounding box are 

listed as “B-width”, “B-height”, and “B-depth” in units of pixels. In this case, 

“B-depth” represents the height of the nuclei. Convert the height to micrometers 

using the image acquisition parameters.

Elpers et al. Page 17

Curr Protoc. Author manuscript; available in PMC 2024 July 01.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



13. Compare results between cells in unconfined conditions, confinement, and in the 

control device. Confinement should result in a decrease in nuclear height (Figure 

4C).

SUPPORT PROTOCOL 1: Fixation and staining of cells after confinement

Cell fixation is a common practice used to preserve cellular structure and morphology 

for further analysis while reducing the risk of sample degradation. Cell fixation is often 

necessary for immunofluorescence (IF) analysis of intracellular proteins or for fluorescence 

labeling using cell impermeable dyes. After fixation, cells are permeabilized to allow 

intracellular labeling and then incubated in blocking solution to reduce non-specific 

antibody staining. For immunofluorescence labeling, the fixed sample is then typically 

incubated with a primary antibody directed against the protein of interest and then, after 

repeated washing to remove unbound primary antibodies, incubated with a secondary 

antibody specific to the host species of the primary antibody. In addition, fixed cells 

can also be labeled with fluorescent stains labeling specific cellular structures, such as 

DNA using DAPI, or F-actin using fluorescently labeled phalloidin. In this protocol, we 

provide instructions for the fixation of cells in the confinement devices and for subsequently 

staining the cells with phalloidin to visualize F-actin (Figure 6). The protocol can be readily 

adjusted to other applications, and we also include instructions for antibody staining for IF 

applications.

Materials:

Cell fixation agent (e.g., 4 % paraformaldehyde, see recipe in Reagents and Solutions)

1× DPBS (see recipe in Reagents and Solutions)

0.1% Triton solution (see recipe in Reagents and Solutions)

Blocking solution (3% BSA in PBS, see recipe in Reagents and Solutions)

Phalloidin Alexa Fluor 568 (ThermoFischer, cat. no. A12380)

Fluorescent dye for DNA (e.g. DAPI, Hoechst)

Chemical fume hood

Brightfield microscope

Benchtop rocking platform shaker (VWR, cat. no. 75832-308 or equivalent)

Flat tip tweezer (e.g., VWR, cat. no. 89259-954)

Inverted fluorescence microscope (with applicable fluorescence excitation/emission filters) 

or inverted confocal microscope with 20× objective or higher with mounted microscope 

camera for image acquisition (motorized stage optional, but useful)

Microscopy software for image acquisition (e.g., Zeiss ZEN Black, Zeiss ZEN Blue)
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Protocol steps with step annotations:

1. Follow the confinement protocol described in Basic Protocol 2 and confine cells 

for the intended period of time. Depending on the application, we recommend 

inducing confinement for 2-24 hours. Alternatively, instead of imaging cells 

immediately post-confinement to confirm nuclear height (Basic Protocol 2, step 

20), confinement can be confirmed after cell fixation.

2. After confining cells for the desired time, gently aspirate media from the 35 mm 

glass dish with the cells, without disturbing the agarose device, weight holder 

and weights.

3. In a chemical fume hood, add 1 mL of fixation agent and wait 1 hour for fixation 

to occur. For our application, we use pre-warmed 4% paraformaldehyde (PFA) 

for fixation, which works well for phalloidin and DAPI staining. Other labeling, 

however, may require alternative fixation methods such as methanol or ethanol-

based protocol. The specific fixation method should be selected depending on the 

cell type used and application of interest (Hobro & Smith, 2017).

4. Carefully remove fixation agent and replace with 1 mL of PBS. Gently lift the 

weight holder and weight off the agarose device. Using tweezers, carefully peel 

the agarose device off the fixed cells. Wash cells 2-times with 1.0 mL DPBS for 

5 minutes each.

After the initial fixation, the confined cell morphology should be preserved, even 

after removing the agarose pad. Sufficient fixation is required to ensure that 

cells retain their morphology and do not detach from the glass bottom when the 

agarose device is removed.

5. Examine cells using a brightfield microscope. You should be able see the circular 

areas where the micropillars were, as the squished cells under the micropillars 

are typically peeled off together with the agarose device. Cells confined to 3 μm 

will appear to be flatter and have increased cross-sectional areas compared to 

cells confined to 10 μm or unconfined cells.

At this point, samples can be stored in DPBS at 4°C until staining, or you can 

proceed with the staining protocol. For longer term storage, add sodium azide to 

the DPBS (0.02% w/v) to prevent microbial contamination. Note that for some 

sensitive applications (e.g., analyzing protein phosphorylation), cells should be 

stained and imaged as soon as possible.

6. Permeabilize cells using a 0.1% Triton solution at room temperature for 15 

minutes. Wash cells 2-times at room temperature with 1.0 mL PBS for 5 minutes 

each.

7. Aspirate PBS and add 1 mL of blocking solution to the dish. Incubate for 1 hour 

on a benchtop rocking platform set to low speed at room temperature.

8. For phalloidin staining: add 250 μL of 1:200 Phalloidin-568 in PBS. Incubate 

at room temperature rocking for 1 hour. For immunofluorescence labeling: add 
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250 μL primary antibody solution to dish and incubate at 4°C overnight on a 

benchtop rocking platform.

For immunofluorescence labeling, primary antibody concentrations typically 
range from 1:100- 1:500 in PBS containing 3% BSA. The exact concentrations 
will depend on the antibody and protein of interest and should be optimized 
for each new target. For some antibodies, incubation at 4°C for a longer period 
may be preferable. Secondary antibody-only controls should be used to address 
non-specific binding. For phalloidin staining, skip steps 10 and 11 and resume at 
step 12. Phalloidin-568 is a fluorescent stain already conjugated to a fluorophore, 
so no secondary antibody is needed. Phalloidin is also available with many other 
fluorescence labels.

9. Aspirate antibody or staining solution from samples. Wash with PBS 2-times for 

5 minutes each on a rocking platform.

10. For immunofluorescence labeling: incubate samples on benchtop rocking 

platform for 1 hour with secondary antibody solution compatible with primary 

antibody used. We recommend a secondary antibody concentration of 1:250 

diluted in PBS containing 3% BSA, but the specific concentration will depend on 

the particular antibodies used.

11. Aspirate solution from samples. Wash with PBS two-times for 5 minutes each on 

a rocking platform at room temperature.

12. Stain with DAPI at a dilution of 1:500 in PBS for 30 minutes at room 

temperature on rocking platform. Wash 2-times for 5 minutes each with DPBS 

and store samples in 0.5 mL DPBS at 4°C.

DAPI is a versatile, robust, and bright nuclear stain that binds to DNA. 

Alternatively, Hoechst or other DNA intercalating dyes can be used. The 

concentration of the dye should be optimized for each application.

13. The fixed and stained cells can be temporarily stored at 4°C for further analysis 

or imaged right away on a microscope. For longer term storage, sodium azide 

should be added to the DPBS solution (0.02% final concentration). Images 

of the stained cells can be acquired on a confocal or wide-field fluorescence 

microscope, depending on the specific application. We recommend acquiring 

high resolution Z-stacks on a confocal microscope to confirm the confined 

morphology of the cells.

SUPPORT PROTOCOL 2: Live/dead staining of cells during confinement

Staining living cells, combined with time-lapse microscopy and multi-positions setting, can 

be used to assess dynamic effects of 3D confinement, and allows the comparison of the same 

cells pre- and post-confinement, thereby reducing cell-to-cell variability. Additionally, live/

dead cell staining is useful to ensure cell viability of cells at the end of various assays. Here, 

we present a basic protocol for live/dead staining of MDA-MB-231 cells with propidium 

iodide after 24 hours of 3-μm height confinement, 10-μm height confinement (control), and 
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in unconfined cells. Our results demonstrate that cells remain viable even under prolonged 

confinement to 3-μm height, with only cells that were located under the agarose micropillars 

and thus were squished completely staining positive for propidium iodide (Figure 7). This 

protocol can also be applied to other live cell stains, as we show that the cell stain diffuses 

throughout the confinement device within one hour of adding the staining reagent.

Materials:

All materials from Basic Protocol 2

Live/dead cell stain of interest (e.g., propidium iodide, which labels dead cells, used at 1 

μg/mL in cell culture media)

Protocol steps:

1. Follow the confinement protocol described in Basic Protocol 2 to apply 

confinement.

For live cell imaging of cells starting before confinement is applied, the desired 

cell stain of interest can already be applied to the cells prior to applying the 

confinement device. In that case, it is important to avoid moving the dish with 

the cells when applying the device, or carefully repositioning it after applying 

the confinement device to capture the same cells again. Note that prolonged 

incubation of cells in media containing propidium iodide can result in false 

positive propidium iodide labeling, as even live cells may take up the dye 

over time. Thus, for lived/dead staining with propidium iodide, we recommend 

applying the propidium iodide only at the end, as described here.

2. After incubating confined cells for the desired amount of time, gently aspirate 

media from the edge of the dish, make sure not to move the confinement device.

3. Add 1 mL of cell culture media containing the cell stain of interest to dish, just 

outside of the confinement device. For our live/dead stain application, we used 1 

μg/mL of propidium iodide in Fluorobrite media.

It is essential to keep the weight holder and weight on the agarose device during 

the staining. This is to ensure the agarose does not detach from the substrate and 

shear the cells.

4. Incubate the dishes at 37°C for 1 hour. We found that diffusion of the cell stain 

across the cells in the device consistently occurs by 1 hour.

If performing experiments at room temperature (which is suitable for many 

cell types), it may be necessary to extend the incubation time to ensure that 

propidium iodide has diffused completely in all areas below the agarose device.

5. Gently aspirate the media from the outside of the device. For live cell imaging, 

e.g., to quantify the fraction of cells positive for propidium iodide, add 1 mL of 

cell imaging media to the dish. The cells can then be imagined on a fluorescence 

microscope or maintained in culture. Alternatively, if using a live-cell stain 
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compatible with fixation, the cells in the device can be fixed and stained using 

Support Protocol 1.

REAGENTS AND SOLUTIONS:

Cell culture media (prepare in sterile environment)

• 445.0 mL Dulbecco’s Modified Eagle Medium (DMEM) (Gibco/ThermoFisher, 

cat. no. 11965092)

• 50.0 mL Fetal Bovine Serum (Avantar by VWR, cat. no 89510-186)

• 5.0 mL Penicillin/Streptavidin (Gibco/ ThermoFisher cat. no. 15070-063)

Fluorobrite medium (prepare in sterile environment)

• 42.5 mL Fluorobrite™ Dulbecco’s Modified Eagle Medium (Gibco/

ThermoFisher, cat. no. A1896701)

• 1.5 mL 1M HEPES for imaging without 5% CO2 (Gibco/ThermoFisher cat. no. 

15630080)

• 0.5 mL 100× GlutaMAX (Gibco/ThermoFisher cat. no. 35050061)

• 5.0 mL Fetal Bovine Serum (Avantar by VWR, cat. no. 89510-186)

• 0.5 mL Penicillin/Streptavidin (Gibco/ ThermoFisher cat. no. 15070-063)

1× DPBS (tissue culture grade, prepare in sterile environment))

• 5.0 mL 10× DPBS (Gibco/ThermoFisher cat. no. 14-200-075)

• 45.0 mL autoclaved DI water

10× PBS (non-tissue culture grade)

• 1.4 g/L Potassium dihydrogen phosphate (KH2PO4)

• 90 g/L Sodium chloride (NaCl)

• 7.9 g/L di-Sodium hydrogen phosphate anhydrous (Na2HPO4 7H2O)

• 1.0 L DI water, adjust to pH 7.4

1× PBS (non-tissue culture grade)

• 900 mL DI water

• 100 mL 10× PBS (see above)

4% PFA

• 4.0 g paraformaldehyde (Sigma, SKU 158127-500G)

• 100 mL warm PBS

• Store at 4°C
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0.1% Triton

• 0.5 mL Triton X100 stock (Sigma, SKU X100-500ML)

• 49.5 mL 1× PBS (see recipe above)

Blocking solution

• 1.5 g bovine serum albumin (Sigma Aldrich, cat. no. A7906)

• 50 mL 1× PBS

• Vortex for 30 seconds and rock on benchtop rocking platform until BSA 

dissolves

• Store at 4°C

COMMENTARY:

Background Information:

Researchers have long been studying the effect of mechanical forces and the physical 

environment on cells, as it is well recognized that these factors can substantially modulate 

cellular fate and function. This research is now generally categorized as ‘mechanobiology’. 

In recent years, an increasing interest has fallen on the cell nucleus, and nuclear 

mechanobiology has gained a spotlight as a promising avenue to elucidate the molecular 

mechanisms surrounding various diseases and physiological processes, ranging from cancer 

metastasis to immune cell function and muscle diseases. Although various cell confinement 

systems have been developed over the past 15 years, many of the systems come with 

their own challenges and limitations, particularly when applying prolonged confinement. 

To address these challenges, and after having tested numerous confinement systems in 

our laboratory, we have developed a robust confinement assay that can be easily tailored 

to specific applications due to its simple design. While ultimately in vivo assays are 

still needed to fully recapitulate the 3D biological microenvironment of cells, the system 

presented here provides a cost effective, reliable in vitro assay to probe consequences 

of cell confinement and nuclear deformation with precise control over the degree of 

confinement. The main advantage of this device is the simple concept of adding weight 

to the agarose micropillars to induce cell confinement. This device does not require costly 

external hardware, specially designed microscope stages, or other machined parts. Although 

the cost and time consideration to fabricate the silicon wafer must be taken into account, this 

is a relative low one-time costs that should not exceed a few hundred dollars, and that can 

also be outsourced to commercial or academic service providers if necessary.

Critical Parameters:

Fabrication of the silicon wafer—During the fabrication of the silicon wafer, it is 

essential to precisely follow the protocol in the critical steps listed below, as small variations 

can result in highly variable outcomes or non-usable wafers. For the lower layer SU-8 

features, baking steps should be timed precisely, while for the upper layer SU-8 features, 

the pre- and post-exposure bake times are more flexible. It is essential to always let the 

wafer cool to room temperature after baking before starting the next step. When exposing 
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the silicon wafer, always take note of the UV source power and adjust the exposure time 

proportional to the change in lamp power if needed. The hard bake step is critical to 

ensure that upper layer features do not delaminate after multiple casts of agarose from the 

silicon wafer. As with any other baking step, let the silicon wafer cool gradually to room 

temperature.

Cell seeding—Proper cell seeding density is essential to ensure consistent results using 

the same amount of weight, as a larger number of cells will offer more resistance to 

confinement. Although more weight can be added if the cells are seeded at a high density 

to ensure confinement, we found that this approach often leads to over confinement, likely 

due to the collapse of the micropillars under the weight. Similarly, if the cell density is 

lower than expected, over confinement can occur if the standard weight is applied. In our 

experience, we found that dishes with 50-70% cell confluency work best to achieve uniform 

and robust confinement even for extended periods of time.

Preparing the agarose confinement device—Prior to preparing the agarose devices, 

rinse the silicon wafer once with DI water to ensure that no dust or other agarose is left on 

the wafer. Completely dry the wafer before casting the agarose. Since agarose is a hydrogel 

that contains a large volume fraction of liquid, it is important to dissolve the agarose in 

tissue culture grade DPBS to ensure that the pH in the cell culture media does not change 

when the device is applied to the cells. If the agarose is dissolved in PBS outside the range 

of 7-7.3, the amount of media the agarose device absorbs once placed onto the cells will be 

affected and can negatively impact the cells and cause cell death. Conversely, dissolving the 

agarose in water will cause osmotic swelling of the cells once the agarose device is placed 

into the dish. We highly recommend preparing fresh agarose for each experiment. While 

handling the agarose devices, it is essential to use flat-tip tweezers and gentle handling to 

avoid puncturing the agarose. We recommend preparing the agarose devices immediately 

prior to the confinement assay to ensure that the agarose devices do not dry out.

Cell confinement and imaging—It is essential to soak the agarose device in cell media 

for 1 minute prior to the assay. Under-soaking the device risks the agarose device absorbing 

too much media when placed in the dish, which can result in over-confining the cells. After 

starting the cell confinement, avoid moving the dishes too often, as this can cause the weight 

holder and weight to slide around and either (1) induce non-uniform confinement if the 

weight is not distributed evenly, or (2) cause the agarose to slide and shear the cells. When 

imaging the cells, be sure to avoid saturation of fluorescent markers, as this can affect the 

height and cross-sectional area measurements of the nuclei.

Cell fixation—It is essential to keep the agarose firmly in contact with the bottom of the 

dish during fixation by keeping the weight and weight holder in place during incubation. If 

the weight and weight holder is removed prematurely, the agarose can detach and shear cells 

off the dish.
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Troubleshooting:

Table 4 includes a troubleshooting guide for issues that can occur during the described 

protocols. We have included probable causes of the issues observed, along with solutions we 

found helpful to address common problems.

Understanding Results:

The confinement of cells can be confirmed by acquiring Z-stack images and measuring 

nuclear height (Figure 1C). Confined nuclei typically appear flat in the X-Z view as shown 

in the representative images, while unconfined nuclei will appear more rounded in the X-Z 

view. Given the limited resolution in the Z-axis, even when using high NA objectives, we 

typically allow for 0.5 μm of error when measuring nuclear height (i.e., nuclei confined 

to 3 μm should measure 2.5-3.5 μm in height), and this could vary further depending on 

the imaging parameters set. We recommend using the same imaging parameters across 

experiments to achieve consistent measurements of nuclear height. Cells confined to 3 μm 

tall micropillars should also exhibit an increase in nuclear cross-sectional area (Figure 4B) 

as their nuclear height decreases (Figure 4C) when compared to cells confined to 10 μm 

tall or in unconfined conditions. For the MDA-MB-231 cells used in our example, the 

nuclei measured to be around 7 μm high on average when grown in unconfined conditions. 

Thus, confinement to 10-μm height does not affect nuclear height or cross-sectional area 

compared to unconfined cells, whereas confinement to 3-μm height decreases nuclear height 

and increases nuclear cross-sectional area. Additionally, we demonstrate that confinement 

of MDA-MB-231 cells below 5 μm height induces nuclear envelope rupture (Video 1), 

as previously reported (Denais et al., 2016; Nader et al., 2021; Shah et al., 2021). 

Consequently, the confinement device can be used to induce nuclear envelope rupture in 

cells and to study the downstream consequences such as induction of DNA damage and 

activation of DNA damage response pathways.

For initial validation of achieving uniform confinement across the device, we recommend 

adding fluorescently labeled dextran to the cell media before applying confinement. When 

combined with 3D confocal imaging, this will enable to visualize the space occupied by 

media between the glass bottom/cells and the agarose pad (Figure 5A). This approach is 

particularly useful to ensure the agarose micropillars are touching the glass dish, and the 

apical cell surface is in contact with the agarose when applying severe confinement. The 

contact of the micropillars with the glass dish can also be confirmed without using dextran 

by looking for circular patches of completely squished cells under the agarose micropillars 

(Figure 5B). Cells on the edge of the micropillars will be easily distinguished using the 

orthogonal view as they will show an apparent change in height at the location of the pillar.

Fluorescent labeling or immunofluorescence of cellular structures should demonstrate clear 

effects in conditions where the vertical confinement is lower than the height of unconfined 

cells. The exact results will depend on the application. In our example, we stained MDA-

MB-231 cells with phalloidin and DAPI to visualize F-actin and DNA, respectively (Figure 

6). Because the nuclei are fixed under the device during confinement for immunostaining 

applications, the nuclear height should not change compared to before fixation, and you 

should confirm that cells of interest are confined to the desired height. Our propidium iodide 
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staining shows that cells remain viable even after 24 hours of confinement (Figure 7). If cell 

viability is reduced substantially during or after confinement, this indicates that cells were 

likely over-confined or that the pH or osmolarity of the solution changed due to the addition 

of the device (see Troubleshooting tips).

Time Considerations:

Design and fabrication of confinement device wafer—The design of this 

photomask takes 2 to 4 hours. More complex designs may take much longer. Writing and 

developing the photomask will take 3 to 4 hours. Piranha cleaning one silicon wafer takes 

5 to 8 minutes, and the wafer must be dehydrated overnight before use. Lower layer feature 

fabrication (3 μm or 10 μm tall micropillar layer) will take approximately 2 to 4 hours. 

The 500 μm upper layer takes approximately 36 to 48 hours due to the long bake times. 

The final hard bake of the silicon wafer and hydrophobic coating will take approximately 4 

hours. From start to finish, fabrication of one complete wafer will take about one week for 

an experienced user. However, troubleshooting and re-optimization of parameters such as the 

spin recipe, exposure time, bake time, and developer time may require additional time.

Cell confinement and imaging—Coating the 35 mm glass dishes takes 3-5 minutes. 

Passaging and seeding cells takes approximately 30 minutes. This must be done one day 

prior to the confinement assay. Preparation of the agarose devices will take 15-20 minutes. 

For each experiment, it takes approximately 20 minutes from the time of soaking the agarose 

in media to the time of adding the weight and letting the device reach confinement height 

after 10 minutes. For live cell imaging experiments, image acquisition time will depend 

on the parameters chosen. We recommend a confinement time of at least one hour, but 

this depends on the intended application. Cell confinement can be maintained for 24 hours 

or longer. For longer confinement periods, we recommend confirming cell viability using 

appropriate live/dead cell stains, and potentially replacing media every 24 hours.

Immunostaining after confinement—Once the confinement is applied for the desired 

time, washing with PBS and PFA fixation takes approximately 1 hour. Depending on 

the intended immunostaining application, staining, and washing times may vary, but we 

recommend overnight incubation at 4°C for the primary antibody, and 1 hour incubation 

at room temperature for the secondary antibody. Phalloidin and DAPI staining takes 

approximately 2 hours to complete after fixation.

Live cell staining during confinement—We found that after the addition of a live/dead 

cell stain, diffusion under the agarose device can take up to 1 hour to ensure uniform 

labeling. Optionally, the cells may be washed with media for an additional hour.

Supplementary Material

Refer to Web version on PubMed Central for supplementary material.
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Figure 1. Overview of agarose confinement device.
(A) Cross section (left) and top view (right) schematic of the confinement device assembly. 

Assembly includes a 35 mm glass bottomed dish (black), agarose device (blue), weight 

holder (red), and weight (gray). (B) Photograph of confinement device assembly. (C) 

Representative images of MDA-MB-231 cells with nuclei fluorescently labeled with histone 

2B-mNeonGreen under either unconfined, confined to 10 μm, or confined to 3 μm 

conditions. Images are orthogonal views of Z-stacks. Scale bars = 10 μm.
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Figure 2. Confinement device photomask design.
(A) Lower layer photomask design containing the array of micropillars to induce 

confinement and alignment marks for aligning the second layer photomask to the first 

layer of photoresist. (B) Upper layer photomask design for the 500 μm tall layer and 

complementary alignment marks. (C) Overlay of the lower- and upper-layer photomask 

designs. Areas colored in blue and red areas show the pattern that will be exposed to 

UV-light on the wafer. SU-8 is a negative photoresist, so exposed photoresist will become 

insoluble to SU-8 developer, thus forming the intended device design.
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Figure 3. Device design and workflow schematic.
(A) Schematic depiction of a single agarose device. The agarose device (light blue) contains 

an array of micropillars (outlined in black) of a defined height to facilitate confinement. 

The second layer of SU-8 provides a region to cut out each individual device without 

cutting through the agarose micropillars. Images are not drawn to scale. (B) Preparation 

of agarose device from silicon wafer. A plastic ring is placed over the silicon wafer and 

agarose is poured onto the wafer and allowed to set. Individual devices are punched out of 

the agarose and are ready to be used. For simplification, only 4 devices are shown on one 

silicon wafer; however, up to 9 devices can be fabricated on one wafer. (C) Cell confinement 

and imaging. Cells are seeded ~24 hours prior to the confinement assay. Cells are imaged 
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before confinement. Immediately prior to use, the agarose device is soaked in media and 

then immediately placed onto the dish containing cells. The weight holder is placed on top 

of the agarose, and the weight is placed onto the holder. Confinement should occur within 

30 minutes and should be validated via confocal microscopy. This figure uses icons from 

Bioicons, an open-source library of science illustrations.
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Figure 4. Confinement device validation.
(A) Representative images of MDA-MB-231 cells expressing histone 2B-mNeongreen under 

either unconfined, confined to 10 μm, or confined to 3 μm conditions. Yellow lines indicate 

orthogonal viewpoint. Scale bars = 10 μm. (B) Quantification of nuclear cross-sectional area 

of unconfined cells, cells confined to 10 μm, and cells confined to 3 μm. (C) Quantification 

of nuclear height of cells from the three conditions. Data is plotted as measurements from 

individual cells with the mean of each biological replicate indicated by a black dot. n= 

65-162 cells per condition from three independent experiments. ** p < 0.01, **** p <0.0001 

based on one-way ANOVA with multiple comparisons.
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Figure 5. Visualizing agarose micropillars
(A) MDA-MB-231 cells expressing Histone 2B-mNeonGreen were confined to either 3 μm 

or 10 μm height, with FITC-labeled dextran added to the cell media to visualize the space 

between the agarose, agarose micropillars (red dash line), and the cells and glass dish. 

Representative images of both the X-Z and X-Y planes are shown. Yellow lines indicate 

orthogonal viewpoint. (B) The agarose pillars (red dash line) can be visualized without 

dextran in the media to confirm the agarose device is touching the bottom of the dish. Cells 

under the pillars will be completely squished and should measure a height of less than 2μm. 

Yellow lines indicate orthogonal viewpoint. Scale bars = 10 μm.
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Figure 6. Validation of cell viability and immunofluorescence staining after confinement assay.
MDA-M-231 breast cancer cells were stained with Phalloidin-568 to visualize F-actin (cyan) 

and DAPI to visualize nuclei (magenta). Representative images of both the X-Z and X-Y 

planes are shown. Yellow lines indicate orthogonal viewpoint. Scale bars = 10 μm.
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Figure 7. Live/dead staining after 24 hours of confinement.
MDA-MB-231 breast cancer cells expressing Histone 2B-mNeonGreen remain viable after 

24 hours in the device under unconfined, 10 μm confinement, and 3 μm confinement 

conditions. Cells completely squished under the agarose pillars (red) stain positive after 

incubation with propidium iodide. Scale bars = 100 μm.
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Video 1. 
MDA-MB-231 cells expressing NLS-GFP and stained with Hoechst 33342 to label DNA 

experiencing nuclear envelope rupture after confinement to 3 μm tall. Nuclear envelope 

rupture is detectable by rapid leakage of the NLS-GFP from the nucleus into the cytoplasm. 

Scale bar = 10 μm.
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Table 1:

Spin Curves for 3 μm thick layer with SU-8 2002

Step RMP Acceleration /deceleration (rpm/second) Seconds

Ramp up 500 100 10

Spin 600 100 10

Ramp down 100 100 10
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Table 2:

Spin Curves for 10 μm thick layer with SU-8 10

Step RMP Acceleration /deceleration (rpm/second) Seconds

Ramp up 500 100 10

Spin 3300 100 33

Ramp down 100 100 35
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Table 3:

Spin Curves for 500 μm thick layer with SU-8 2150

Step RMP Acceleration /deceleration (rpm/second) Seconds

Ramp up 500 100 10

Spin 650 100 60

Ramp down 100 100 15
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Table 4.

Troubleshooting guide for cell confinement

Problem Possible Cause Solution

Immediate over 
confinement and 
cell death after 
adding the agarose 
device, before 
adding weights

The agarose is absorbing the cell medium 
due to inefficient soaking of agarose device 
or altered pH of agarose.

Soak the agarose for a longer time or reduce its thickness by using 10 
mL of agarose solution instead of 15 mL.
Ensure the pH of the PBS used to make the agarose is ~7.1 or the same 
pH as cell culture media.

No confinement 
occurs

Cells are too confluent.

Agarose micropillars were damaged when 
cutting or handling the device causing 
displacement of agarose and interfering with 
the device being able to evenly touch the 
dish.

Not enough weight was applied.

Not enough time has passed for confinement 
to occur.

Reduce the number of cells when seeding to get a 50% confluency.

Recast agarose and carefully cut out new devices. Be sure to use flat 
tweezers and do not forcefully clamp down on the agarose device with 
tweezers.

Add more weight to the device. We recommend adding weight in 5 to 
10 gram increments. 

Robust confinement should occur within 30 minutes. If this is not the 
case, incubate cells for 30 more minutes, check nuclear height, and then 
proceed to try and add additional weight.

Over confinement Cells are not confluent enough.

Too much weight is applied.

Increase the cell density until obtaining 50% to 70% confluency.

Reduce the amount of weight added to the device.

Curr Protoc. Author manuscript; available in PMC 2024 July 01.


	Abstract
	INTRODUCTION:
	BASIC PROTOCOL 1: Design and fabrication of the confinement device wafer
	Materials:
	Protocol steps with step annotations:
	Design and generate photomasks, prepare silicon wafers
	SU-8 fabrication of 3 μm lower layer features (use first wafer for this)
	SU-8 fabrication of 10 μm lower layer features (use second wafer for this)
	SU-8 fabrication of 500 μm upper layer features and final processing (apply to both wafers)

	BASIC PROTOCOL 2: Cell confinement assay
	Materials:
	Protocol steps with step annotations:
	Extracellular matrix coating and cell seeding
	Preparing cells for confinement and imaging
	Preparing the agarose confinement device
	Cell confinement
	Image analysis with Fiji/Image J
	Quantification of nuclear cross-sectional area to confirm confinement
	Quantification of nuclear height to confirm confinement


	SUPPORT PROTOCOL 1: Fixation and staining of cells after confinement
	Materials:
	Protocol steps with step annotations:
	SUPPORT PROTOCOL 2: Live/dead staining of cells during confinement
	Materials:
	Protocol steps:
	REAGENTS AND SOLUTIONS:
	Cell culture media (prepare in sterile environment)
	Fluorobrite medium (prepare in sterile environment)
	1× DPBS (tissue culture grade, prepare in sterile environment))
	10× PBS (non-tissue culture grade)
	1× PBS (non-tissue culture grade)
	4% PFA
	0.1% Triton
	Blocking solution

	COMMENTARY:
	Background Information:
	Critical Parameters:
	Fabrication of the silicon wafer
	Cell seeding
	Preparing the agarose confinement device
	Cell confinement and imaging
	Cell fixation

	Troubleshooting:
	Understanding Results:
	Time Considerations:
	Design and fabrication of confinement device wafer
	Cell confinement and imaging
	Immunostaining after confinement
	Live cell staining during confinement


	References
	Figure 1.
	Figure 2.
	Figure 3.
	Figure 4.
	Figure 5.
	Figure 6.
	Figure 7.
	Video 1.
	Table 1:
	Table 2:
	Table 3:
	Table 4.

